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1. Qu 
1.0 Questions relating to USDA 

Employee/Contractor Account Creation 
Employee and Contractor FAQs 

1.1 Which employees and/or contractors should apply for a USDA 
eAuthentication Account with Level 2 Access? 

There is no need for employees and/or contractors to apply for an eAuthentication account. 
An eAuthentication is automatically created for USDA employees and contractors during the 
onboarding process.   

 
If you have not received a registration email, please contact your Agency Registration Lead. Click on the link 
below to display a list of ARLs. 
Agency Registration Leads page 

 

1.2 How do I register for my Employee/Contractor account? 

For step-by-step instructions of the eAuthentication account registration process, please view 
the Internal Registration Job-Guide. 

 

1.3 How can I reduce the risk of an unsuccessful online registration? 

a. Carefully read all of the instructions provided by your Agency Registration Lead and the 
eAuthentication registration web pages. 

b. Ensure that you launch the registration process by clicking on the link contained within the 
registration email you have received from the eAuthentication system. Do not use a 
bookmarked link. Also, do not use the eAuthentication website to register for an external 
user (i.e., Customer) account. 

 

1.4 What happens when the information displayed is not correct during 
online registration? 

In Step 2 of the internal registration process, the system will display your employee/contractor 
information from your HR record. Please check to ensure this information is correct. 

Agency/Employee Type:- From your Human Resources Records 

First Name:- From your Human Resources Records 

Last Name:- From your Human Resources Records 

If you find that your information is incorrect, stop the online registration and contact your 
Human Resources representative (if you are an employee) or supervisor (if you are a 
contractor). They are able to assist you in updating your information.  

Once the update is complete, this information should be available to eAuthentication. 
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1.5 Why am I being prompted to answer questions after logging in? 

We use these questions to verify your identity during our self-service password recovery 
process. This set of questions and your answers are helping us accomplish some important 
goals, including: 

a. Increasing the security of your account. The answers to these questions are not easy to 
research. 

b. Making it easier for you to retrieve your forgotten password. It is our hope that the 
security questions and answers will be more memorable for all account owners. 

 

1.6 If I move from one agency to another, do I have to get a new User ID? 
There is no need to register for a new User ID. Personnel information is periodically updated 

within the eAuthentication system and your account will reflect the new agency. 

 

1.7 I have not received a Registration email or have deleted it. How do I 
obtain one? 

To register for an eAuthentication internal account with Level 2 access, you will need to receive 
a Registration email. If you have not received this email, or no longer have this email, please do 
the following: 

a. Contact an Agency Registration Lead for your agency. 
Click on the link below to display a list of ARLs. 
Agency Registration Leads page 

b. Provide the ARL with an email address. 
The ARL will confirm your email address, or if none exists, you will need to provide them 
a valid personal or government-issued email address. 

c. Wait up to 24 hours for the registration email to arrive. 
 

If you do not receive the Registration email within 24 hours of the ARL update, please 
try the following: 

 Check your "junk" folder, as some email applications may incorrectly place this 
email there. 

 Look in folders other than your "Inbox" such as "SPAM," "Junk Mail," "Bulk" or 
"Suspected SPAM." 

 Some Internet Service Providers include a service that captures suspected SPAM 
and maintains these files outside of your individual email account. 

 Turn off your email provider's filters. 

 Turn off your personal email filter settings. 

If you need additional assistance, click here for support contact information. 
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Agency Registration Lead FAQs 

1.8 What are the responsibilities of the Agency Registration Lead? 

You will support and execute USDA eAuthentication registration activities and initiatives, 
maintain intra-departmental communication efforts in regard to employee/contractor 
credentialing, and coordinate with application owners who plan to use the new credentials to 
protect their applications. Specifically, you will: 

a. Assist employees and contractors in locating their HR Representative/Contracting 
Officer. 

b. Assist employees and contractors in updating their email address which will initiate the 
automated registration process. 

c. Customize instruction templates / Job Aids and communicate them to agency 
employees and contractors in accordance with your agency initiatives. 

 

1.9 What role do Human Resource staff and Contracting Officers play in the 
Employee/Contractor Registration process? 

A Human Resources representative creates an Employee HR record as per their standard 
procedure, and this information flows to the eAuthentication system. (Likewise, Contracting 
Officers or their designee(s) enter contractor information into NEIS/NFC Person Model). If the 
record is complete and also includes the employee's email address, the employee will receive 
an automatic invitation to register for an eAuthentication account. 

 

1.10 What are the benefits of the Employee/Contractor Registration process? 
The registration process is designed to improve the time it takes to register for an 

eAuthentication internal account. The benefits are: 

1.10.1   An employee or contractor will be able to register within 2 or 3 days of being 
hired, depending upon the timing of the HR feeds to the eAuthentication 
system. 

1.10.2   Increased productivity for new employees and contractors needing immediate 
access to eAuthentication-protected applications. 

1.10.3   Employees will no longer need their Personnel or Earnings and Leave Statement. 
1.10.4     Quicker access to AgLearn for mandatory trainings. 
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2.0 Questions relating to Customer Account 
Creation 
2.1 Who can use eAuthentication? 

Any public customer who would like to conduct business with the USDA can establish an 
eAuthentication account on this website. However, an account with Level 2 access is required 
to conduct official business transactions with the USDA via the Internet. 

USDA Employees and Contractors may register for a Public Customer eAuthentication Account 
ONLY when they would like to conduct PERSONAL business with the USDA. Do NOT register for 
a Customer Account if you need an internal account! Only internal accounts should be used for 
job-related functions at USDA websites. If you are a USDA Federal Employee or Contractor, 
you should use the USDA eAuthentication internal account. 

 

2.2 Do I have to apply for a Level 1 account and then obtain another one for 
Level 2 access? 

No. You only need a single account to do business with the USDA at any eAuthentication- 
protected website. However, an account with Level 2 access is required to conduct official 
electronic business transactions with the USDA via the Internet. Once you have a Level 1 
account, you can upgrade to Level 2 access by proceeding with our identity-proofing process. 

 

2.3 The Customer Profile won’t accept the User ID I have created. Why? 
The User ID is already in use by someone else. Since User IDs are required to be unique, you 

cannot use the same one. 

 

2.4 I signed up for an eAuthentication account with Level 1 or 2 access. What 
is my next required step? 

ALL levels of eAuthentication access require you to follow the directions in the Confirmation 
email you received at the email address provided in your profile. Please follow the steps in 
Section 2.5 of this document, “I don’t see a confirmation email from the USDA.” If you need 
additional assistance, click here for support contact information. 
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2.5 I don’t see a confirmation email from the USDA. 

It is common that anti-spam software in your email application or at your email servers can 
interfere with the USDA's confirmation email message to you. 

Please try the following: 
a. Check your "junk" folder, as some email applications may incorrectly place this email 

there 
b. Look in folders other than your "Inbox" such as "SPAM," "Bulk," or "Suspected SPAM." 
c. In addition, some Internet Service Providers include a service that captures suspected 

SPAM and maintains these files outside of your individual email account. 
 

If you do not receive the confirmation email after 24 hours: 
a. Turn off your email provider's filters. 
b. Turn off your personal email filter settings. 
c. Please check that you have disabled any forwarding or anti-spam measures. 

 

If it has been more than one day since the account was created, and you have tried all the 
above steps, click here for support contact information 

 

2.6   I never found my confirmation email it’s been a day and still no 
confirmation email. What now? 

If you need additional assistance, click here for support contact information. Provide your first 
and last names and the User ID for the account you created.  

 

2.7  I can’t get the link in the confirmation email to work. What now? 

At the bottom of the confirmation email is a long string of alphabetic and numeric characters. 
Copy and paste the entire string of characters into the address window of your browser, and 
press the Enter key. 

Note: If you need additional assistance, click here for support contact information. Please 
include your User ID and the date you attempted to confirm your email. 

 

2.8 I signed up for an account with Level 1 access and confirmed my email 
address. What now? 

Your account is ready to use! You can access any USDA application that permits an account with 
Level 1 access. 
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2.9 I signed up for an account with Level 2 access and confirmed my email 
address. What now? 

You must visit a local USDA Service Center in person for identity proofing. (Find an LRA) Take 
your government-issued photo ID to the nearest USDA Service Center most convenient to you 
for identity-proofing. 

The government-issued photo IDs that are accepted for eAuthentication Level 2 account 
activation are: 

2.9.1 State- or Province-issued Driver's License or Photo Identification card from the United 
States or Canada. 

2.9.2 US Military or US Federal Government employment PIV/CAC (Smart) identification card 
(DoD, DoS, DHS, etc.). 

 

2.9.3 Valid passport from one of the following countries: Andorra, Australia, Austria, Belgium, 
Bermuda, Brunei, Canada, Czech Republic, Denmark, Estonia, Finland, France, 
Germany, Greece, Guam, Hungary, Iceland, Ireland, Italy, Japan, Latvia, 
Liechtenstein, Lithuania, Luxembourg, Malta, Mariana Islands, the Marshall Islands, 
Mexico, Micronesia, Monaco, the Netherlands, New Zealand, Norway, Portugal, 
San Marino, Singapore, Slovak Republic, Slovenia, South Korea (Republic of Korea), 
Spain, Sweden, Switzerland, the United Kingdom or the United States of America. 

Note: Your first and last names and date of birth must appear exactly as they appear on your 
government-issued photo ID that you present at the Service Center. If they do not match, you 
will need to create another account that has matching information and use a different User ID. 

 

2.10 I logged into my Level 2 account and was prompted to answer questions. 
Why did this happen? 

USDA eAuthentication is trying to make it easier for all customers to retrieve their forgotten 
password and increase account security. The security questions and answers are a way to make 
your information more personal (memorable) and more difficult to research. You will be asked 
to answer these questions if you forget your password in the future. 

 

2.11 How do I locate my nearest USDA Service Center? 

Please browse to find an LRA. This site will help you to identify a USDA Service Center with an 
LRA, and will provide you with contact information and map directions to help you find it. 
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2.12 I am a USDA employee or contractor; do I need to register for a Customer 
eAuthentication account? 

Most USDA federal employees and contractors should obtain an eAuthentication account; 
however, do NOT create a public customer account unless you wish to conduct personal 
business with the USDA. A public account should not be used for job functionality on USDA 
websites.  

 

2.13 How do I register for a Customer account? 

For step-by-step instructions of the Customer account registration process please review the  

Customer Registration Job Guide. 
 
 
 

3.0 Questions relating to your password or User 
ID 

3.1 How do I keep my eAuthentication account active? 

The eAuthentication system does go through a periodic cleanup of any accounts that have not 
been accessed in over 400 days. If you would like to keep your account active, please log into 
your account at least once per calendar year. 

 

3.2 How do I change my password? 

There are two methods to changing your eAuthentication password. 
If you are able to log into your eAuthentication account, log into your account first. 

3.2.1 Go to the Home page. 

3.2.2 Click on “Update your account” in the Quick Links box. 

3.2.3 Log in using either your LincPass or your User ID and Password. 

1.   If you log in using your LincPass, select the correct certificate. 

3.2.4 Click on “OK.” 

3.2.5 Enter your LincPass PIN when prompted. 
 

Once you have logged into your account, you will need to do the following: 

3.2.6 Go to the Home tab and select “Change my eAuthentication Password” 

3.2.7 Please review Question 3.7 for information about our password guidelines. 

3.2.8 Once you have selected a valid password and confirmed it, please click on the 

“Submit” button. 
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If you are a USDA customer, you can also click on the “Change My Password” option below the 
Password field. 

3.2.9 Press “Continue” under the option for USDA Customers 

3.2.10 Enter your existing User ID and Password 

3.2.11 Please review Question 3.7 for information about our password guidelines. 

3.2.12 Once you have selected a valid password and confirmed it, please click on the 

“Submit” button. 

 
3.3 I’ve forgotten my password. How do I obtain a password reset? 

Please follow the steps below to reset your forgotten password: 
 

a. Go to the Home page. 
b. Click on “Update your account” in the Quick Links box. 
c. Below the “Password” field, click on the “I Forgot my Password?” link. 
d. Follow the steps to reset your forgotten password. 
e. An email will be sent to your email address on record.  

For m ore information, please review one of the following 

guides: 

3.3.1 Forgotten Password Training Guide for Internal Accounts 

3.3.2 Forgotten Password Training Guide for External Accounts 

If you need additional assistance, click here for support contact information. Please include 
your User ID, First Name, Last Name and email address. 

 

3.4 I cannot remember my User ID. How may I recover it? 

Please follow the steps below to recover your User ID: 
a. Go to the Home page. 
b. Click on “Update your account” in the Quick Links box. 
c. Below the “User ID” field, click on the “I Forgot my User ID?” link. 
d. Follow the steps to reset your forgotten User ID. 
e. An email will be sent to your email address on record. 

For more information, please review the Forgotten User ID Customer Training Guide or 
Forgotten User ID Internal Training Guide. 

If you need additional assistance, click here for support contact information. 
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3.5 What are the “Reset My Forgotten Password” feature and the “Retrieve 
My Forgotten User ID” feature? 

Please review the following User Guides for more information on these features: 

3.5.1 Forgotten Password Training Guide for Internal Accounts 

3.5.2 Forgotten Password Training Guide for External Accounts 

3.5.3 Forgotten User ID Internal Training Guide 

3.5.4 Forgotten User ID Customer Training Guide 

 

3.6 Why does the eAuthentication system require such complicated 
passwords? 

eAuthentication protects websites that involve submitting personal and private information, as 
well as financial transactions, via the Internet. eAuthentication security standards are  

consistent with USDA policies as well as those established by the National Institute of Standards 
and Technology (NIST), which determines the security standards for the Federal Government. 

 

3.7 Why is the complexity of my password important to protecting privacy at 
USDA? 

The USDA eAuthentication Service enables USDA customers to confidently share data and 
conduct official business transactions with the USDA via the Internet. 

To learn more about Protecting Privacy at the USDA, read the Privacy Presentation for End  
Users. 

 

3.8 What are the criteria and rules governing passwords within the 
eAuthentication system? 

Please create a password that you will remember. Your password is case sensitive. Passwords must follow 
these guidelines: 

A minimum of 12 and a maximum of 24 alphanumeric and special characters including at least one of each of 
the following: 

 uppercase letter 

 lowercase letter 

 a number 

 one or more of the following special characters ! # $ % = + : ; , ? ~ * - (spaces are not allowed) 

 Dictionary words may not be used in passwords 

 The previous 24 passwords may not be re-used 
 

The key to making your eAuthentication account as secure as possible is creating the strongest possible 
password while making it easy to remember. The following are guidelines that will help you do this: 
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Password Tips: 

 Make your password lengthy. Your password must be a minimum of 12 characters; however the 
longer you make the password, the harder it will be for someone to guess. Therefore, try to make 
your password up to 24 characters long.  
 

 Avoid repeated characters or common character sequences. Do not use more than one or two 
letters or numbers together (for example: “11111111” or “aaaaaaa”.) Also avoid common sequences 
such as “qwertyuiop” , “123456789”, or “abcdefghij”. These sequences are too easily guessed.  
 

 Avoid use of dictionary words of any language. Many hackers use dictionary words of many 
 mainstream languages, including slang, to guess passwords. If you use these in your password, 
 it makes it easier to guess by a hacker.  
 

 Make your password difficult to guess or research. One technique is to pick a favorite quote,  
song lyric, or phrase and use the first character from each word or syllable to build a password. 
 This will help you select a nonsense word that can’t be compared to any known dictionary word and 
should be un-related to any identity details known or researchable about you.  
 

 Avoid obvious character substitutions. Replacing the letter “i” with 1 or the letter “o” with 0  
does little to prevent a password guessing attack.  
 

 Do not use the same password in all systems. If one of the online systems or computers you use is 
compromised, then the attacker could potentially have access to all of your systems. Make sure  
you use a distinctly different password for all of your systems.  
 

Note: Your password will expire according to USDA policy. 
Please review the Tips on Creating a Strong Password guide to learn more about creating a 
strong password for your eAuthentication account. 
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4.0 Questions relating to web browsers and 
eAuthentication website security 

4.1 What kind of browser do you recommend using? 

It is recommended that you use Internet Explorer 8 or higher. Other IE versions and other 
browsers (e.g., FireFox, Chrome) can also be used. 

It is recommended that your browser support 128-bit encryption, accepts cookies, and is 
JavaScript enabled. 

For more information about Internet Explorer, please access Microsoft Internet Explorer support site 
 
 

4.2 I keep getting re-directed back to the login screen after I click the “Login” 
button. 

Enabling “Compatibility View” in Internet Explorer may resolve this issue. To set Compatibility 
View in IE: 

Note: if Compatibility View Settings is not an available option, you may need to contact your 
network administrator for assistance. 

a. Press Alt + T to open the Tools menu in IE 
b. Look for the “Compatibility View” menu option and click on it 
c. This will turn on Compatibility View 

Microsoft also provides a tutorial video on Compatibility View usage: 

http://windows.microsoft.com/en-US/windows7/How-to-use-Compatibility-View-in-  
Internet-Explorer-9 

If setting Compatibility View does not resolve your issue, click here for support contact 
information. 

 

4.3 What is the security level of the registration website? 

All eAuthentication web pages are encrypted with Secure Socket Layer (SSL) encryption. 

The encrypted connection indicates the website is secure and can be verified by seeing the SSL 
symbol (a padlock in Internet Explorer) in the browser. A mouse-over on the symbol shows that 
SSL encryption is being applied to the connection. 
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4.4 Why does the eAuth login page look different on my mobile device? 

The eAuthentication login page was updated to automatically detect mobile devices, and will 
now present a simple, friendly and appropriately-sized login screen to mobile users. 

When you visit an eAuthentication protected application with your mobile device, you will 
automatically be routed to the mobile version of the login page. The page will look like this: 

 
 

 

 

 

If you prefer to use the desktop version of the login page, click “View Desktop Version” below 
the LOGIN button. 

If you need to use the self-service links to remember your User ID, reset your forgotten 
password, or change your password, click “View Desktop Version” and click the links for self- 
service on that page. 

Note: Your device’s browser must be configured to accept cookies; refer to your device manual 
for instructions. 

 
 

 

5.0 Questions relating to My Profile 
Information 
5.1 Why is it important to keep my contact information current? 

The business email address and phone in your eAuthentication profile may be used to keep you 
informed about important eAuthentication matters related to your account. 

For USDA employees/contractors it is also a primary means of communicating with you for 
upcoming, large-scale initiatives, such as HSPD-12. Please take a moment to ensure that your 
contact information is correct, so you don't miss these important announcements. If you would 
like more information regarding the HSPD-12 initiative, please click on the link:  
http://lincpass.usda.gov 
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5.2 How do I change the answers to my security questions? 

Security questions assist in account protection and self-service. If you need to view or 
change the answers to your security questions, please follow these steps: 

5.2.1 Log into eAuthentication Identity Manager by going to https://www.eauth.usda.gov 

and selecting “Update your account” on the left. 

 If you have an Internal USDA eAuthentication account, please use your 

LincPass to log in. 

5.2.2 Click on the “Home” tab and select “Modify My Security Questions.” 
 

5.2.3 Once you have finished modifying or viewing your questions and answers, click the 

Submit button in the bottom right corner of the screen. 

5.2.4 You can exit Identity Manager by either clicking the “Logout” link at the top or by 

closing your web browser. 

 

6.0 Questions relating to “Login with my USDA 
LincPass” 

6.1 What is a LincPass? 

The LincPass is the new USDA employee and contractor identification card. This effort is part of 
the entire Federal government's move toward compliance with the President's Homeland 
Security Presidential Directive 12 (the common identification standard for Federal Employees 
and Contractors), commonly known as HSPD-12. 

For more information about LincPass and HSPD-12, please go to: USDA HSPD-12 Information 

Do you have questions about your LincPass or HSPD-12? 

Send them to the HSPD-12 Help Desk at: USDAHSPD12Help@dm.usda.gov 

 

6.2 I’ve never used my LincPass to log into my USDA computer. How do I use 
my LincPass with my USDA computer? 

Several resource documents and trainings have been created to help you use your LincPass with 
your USDA computer. 

6.2.1 How to use your LincPass 

6.2.2 LincPass Login User Guide 

6.2.3  LincPass Training on AgLearn 
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https://www.eauth.usda.gov/_GlobalAssets/Documents/USDA_OCIO_HowToUseYourLincPass.pdf
https://www.eauth.usda.gov/_GlobalAssets/Documents/USDA_eAuth_LincPassLoginUserGuide.pdf
http://www.aglearn.usda.gov/
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6.3 How do I log into eAuthentication-protected websites with my LincPass? 

The instructions for LincPass eAuthentication logins are: 
a. Verify your LincPass is inserted into the card reader for your USDA computer. 
b. Click the blue “Login with your LincPass (PIV)”. 
c. A pop-up box “Choose a digital certificate” may appear with two items (certificates) 

containing your name. 
d. Select the first or second certificate with your name and click “OK”. 

i. First time users: 

 Try your first certificate 

 If your login fails, then change your selection to your second certificate 
ii. The certificate (first or second) that works for you will remain the same for most 

future logins. 

e. Enter your LincPass PIN if prompted. 
 
 

If you need further instructions, please review the LincPass eAuthentication Login User Guide. 
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